Introduction to Chemical Reaction Engineering Module
Introduction to the Chemical Reaction Engineering Module

© 1998–2013 COMSOL

Protected by U.S. Patents 7,519,518; 7,596,474; 7,623,991; 8,219,373; and 8,457,932. Patents pending.

This Documentation and the Programs described herein are furnished under the COMSOL Software License Agreement (www.comsol.com/sla) and may be used or copied only under the terms of the license agreement.

COMSOL, COMSOL Multiphysics, Capture the Concept, COMSOL Desktop, and LiveLink are either registered trademarks or trademarks of COMSOL AB. All other trademarks are the property of their respective owners, and COMSOL AB and its subsidiaries and products are not affiliated with, endorsed by, sponsored by, or supported by those trademark owners. For a list of such trademark owners, see www.comsol.com/tm.

Version: November 2013

Part number: CM021602

Contact Information

Visit the Contact COMSOL page at www.comsol.com/contact to submit general inquiries, contact Technical Support, or search for an address and phone number. You can also visit the Worldwide Sales Offices page at www.comsol.com/contact/offices for address and contact information.

If you need to contact Support, an online request form is located at the COMSOL Access page at www.comsol.com/support/case.

Other useful links include:

- Support Center: www.comsol.com/support
- Product Download: www.comsol.com/support/download
- Product Updates: www.comsol.com/support/updates
- COMSOL Community: www.comsol.com/community
- Events: www.comsol.com/events
- COMSOL Video Center: www.comsol.com/video
- Support Knowledge Base: www.comsol.com/support/knowledgebase

Part number: CM021602
# Contents

Introduction ................................................. 1  
Chemical Reaction Engineering Simulations ............... 2  
   Modeling Strategy ............................................. 3  
   Investigating Chemical Reaction Kinetics—Modeling in  
   Perfectly mixed or Plug Flow Reactors .................... 4  
   Investigating Reactors and Systems—Modeling Space  
   Dependency ................................................... 5  
Chemical Reaction Engineering Module Interfaces .......... 7  
   The Physics Interface List by Space Dimension and Study  
   Type ........................................................ 10  
The Model Libraries Window ................................. 13  
Tutorial Example: NO Reduction in a Monolithic  
Reactor ......................................................... 14  
   Introduction .................................................... 14  
   Chemistry ...................................................... 15  
   Investigating the Chemical Reaction Kinetics ............ 16  
   Investigating a Plug Flow Reactor ........................ 17  
   Investigating a 3D Reactor ................................. 21  
Summary ....................................................... 28  
References ..................................................... 29  
Note on the Reactor Models ................................. 29
Introduction

The Chemical Reaction Engineering Module is tailor-made for the modeling of chemical systems primarily affected by chemical composition, reaction kinetics, fluid flow, and temperature as functions of space, and time. It has several physics interfaces to model chemical reaction kinetics, mass transport in dilute, concentrated and electric potential-affected solutions, laminar and porous media flows, and energy transport.

Included in these interfaces are the kinetic expressions for reacting systems, in bulk solutions and on catalytic surfaces, and models for the definition of mass transport. You also have access to a variety of ready-made expressions in order to calculate a system’s thermodynamic and transport properties.

While a major focus of the module is on chemical reactors and reacting systems, it is also extensively used for systems where mass transport is the major component. This includes unit operations equipment, separation and mixing processes, chromatography, and electrophoresis. The module is also widely used in educational and training courses to explain chemical engineering, chemical reaction engineering, electrochemical engineering, biotechnology, and transport phenomena.

In addition to its application in traditional chemical industries, it is a popular tool for investigating clean technology processes (for example, catalytic monoliths and reactive filters), applications such as microlaboratories in biotechnology and in the development of sensors and equipment in analytical chemistry.

An overview of the interfaces and their functionality can be found in “Chemical Reaction Engineering Module Interfaces” on page 7.
Simulations in chemical reaction engineering are used for different reasons during the investigation and development of a reaction process or system.

In the initial stages, they are used to dissect and understand the process or system. By setting up a model and studying the results from the simulations, engineers and scientists achieve the understanding and intuition required for further innovation. Once a process is well understood, modeling and simulations are used to optimize and control the process’ variables and parameters. These “virtual” experiments are run to adapt the process to different operating conditions.

Another use for modeling is to simulate scenarios that may be difficult to investigate experimentally. One example of this is to improve safety, such as when an uncontrolled release of chemicals occurs during an accident. Simulations are used to develop protocols and procedures to prevent or contain the impact from these hypothetical accidents.

In all these cases, modeling and simulations provide value for money by reducing the need for a large number of experiments or to build prototypes, while, potentially, granting alternate and better insights into a process or design.
Modeling Strategy

The flowchart in Figure 1 describes a strategy for modeling and simulating chemical reaction processes and systems.

![Flowchart summarizing the strategy for modeling reacting systems or designing chemical reactors.](image)

The strategy suggests first investigating a reacting system that is either space-independent, or where the space dependency is very well-defined. A system where space dependency is irrelevant is usually so well mixed that chemical species concentrations and temperature are uniform throughout and are
only a function of time—this is often denoted as a perfectly mixed reactor. A plug flow reactor is a system where the space dependency is well-defined.

Once the effects of space dependency are removed or well accounted for, both experimental and modeling investigations can concentrate on the reactions themselves, and the rate laws that control them.

The next step is to apply this information to the chemical reactors or systems that are of interest. These, of course, vary in length, width and height, and are also subject to a range of external parameters including inflows, outflows, cooling, and heating. These are space (and time) dependent systems.

Investigating Chemical Reaction Kinetics—Modeling in Perfectly mixed or Plug Flow Reactors

An important component in chemical reaction engineering is the definition of the respective reaction rate laws, which result from informed assumptions or hypotheses about the chemical reaction mechanisms. Ideally, a reaction mechanism and its corresponding rate laws are found through conducting rigidly-controlled experiments, where the influence of spatial and time variations are well known. Sometimes such experiments are difficult to run, and a search of the literature or using the rate laws from similar reactions provides the first hypothesis.

Perfectly mixed or ideal plug flow reactors are the most effective reactor types for duplicating and modeling the exact conditions of a rigidly-controlled experimental study. These virtual experiments are used to study the influence of various kinetic parameters and other conditions on the behavior of the reacting system. Then, using parameter estimation, the reaction rate constants for the proposed reaction mechanisms can be found by comparing experimental and simulated results. The comparison of these results to other experimental studies enables the verification or further calibration of the proposed mechanism and its kinetic parameters.

Modeling a reaction system in a well-defined reactor environment also provides an understanding of the influence of various, yet specific, operating conditions on the process, such as temperature or pressure variations. The more knowledge that is gained about a reacting system or process, the easier it is to model and simulate more advanced descriptions of these systems and processes.
Investigating Reactors and Systems—Modeling Space Dependency

Once a reacting process or system’s mechanism and kinetic parameters are decided and fine-tuned, they can then be used in more advanced studies of the system or process in real-world environments. Such studies invariably require full descriptions of the variations through both time and space to be considered, which, apart from the reaction kinetics, includes material transport, heat transfer, and fluid flow.

Depending on assumptions that can (or sometimes must) be made, these descriptions are done in either 1D, 2D, or 3D, where time dependency can also be considered if it is of importance.

Figure 2: The temperature isosurfaces throughout a monolith reactor used in a catalytic converter. The surface plot shows the concentration profile of one of the reactants.

Once again, comparisons between simulation and results, from either the reactor or system itself, or a prototype of them, should always be done if possible. Models that involve material transport, heat transfer, and fluid flow often involve generic material parameters that are taken from the literature or from systems that may be
slightly different, and these may need to be calibrated to improve the accuracy of
the model.

When a model’s accuracy has been ascertained, then it becomes a model that can
be used to simulate the real-world chemical reactor or process under a variety of
different operating conditions. The understanding that results from these models,
as well as the concrete results they provide, go toward developing or optimizing a
chemical reactor with greater precision, or controlling a system with more
confidence.
Chemical Reaction Engineering Module Interfaces

Figure 3 shows the chemical reaction engineering interfaces available specifically with this module in addition to the COMSOL Multiphysics basic license. You can use these physics interfaces to model chemical species transport, fluid flow, and heat transfer and make modeling easier, something that is briefly discussed next. See also “The Physics Interface List by Space Dimension and Study Type” on page 10.

Figure 3: The physics interface list for the Chemical Reaction Engineering Module as shown in the Model Wizard for a 3D model.

Chemical Reaction and Mass Transport

The Reaction Engineering interface includes all of the tools required to simulate chemical reaction kinetics in well-defined environments. It sets up simulations of reversible, equilibrium, and irreversible reactions in volumes or on surfaces. You can study the evolution of species concentrations and temperature in controlled environments described by batch, continuous stirred-tank, semibatch, and plug flow reactors. Parameter estimation can also be performed, which then requires a license for the Optimization Module.

The Surface Reactions interface models reactions involving surface adsorbed species and species in the bulk of a reacting surface. The physics interface is typically active on a model boundary, and is coupled to a mass transport interface active on a model domain. This physics interface can be used together with the
following species transport interfaces, Reacting Flow interfaces, and the Electrochemistry interfaces. The Electrochemistry interfaces require the addition of one of the Batteries & Fuel Cells Module, the Corrosion Module, the Electrochemistry Module, or the Electrodeposition Module. Predefined expressions for the growth velocity of the reacting surface makes it easy to set up models with moving boundaries.

The Transport of Diluted Species interface simulates chemical species transport through diffusion, convection (when coupled to fluid flow), and migration in electric fields for mixtures where one component, a solvent, is present in excess.

The Transport of Concentrated Species interface models chemical species transport by diffusion, convection, and migration in mixtures where transport properties, such as diffusion, depend on the composition of the mixture. This interface supports multicomponent transport models given by Fickian diffusion, a mixture-average model, as well as the Maxwell-Stefan equations.

The Nernst-Planck Equations interface includes a migration term, along with convection and diffusion mass transport, together with an equation that guarantees electroneutrality. It can be used for both dilute and concentrated mixtures and a term to describe the electric potential is also included in the interface.

The Species Transport in Porous Media interface is tailored to model mass transport in porous media. It supports cases where either the solid phase substrate is exclusively immobile, or when a gas-filling medium is also assumed to be immobile.

The Laminar Flow interface under Reacting Flow combines the functionality of the Single-Phase Flow and Transport of Concentrated Species interface. The Reacting Flow in Porous Media, Transport of Diluted Species interface is used to treat diluted reacting mixtures transported by a free and/or porous media flow. The component coupling for the velocity field is set up automatically. In addition, effective diffusion coefficients in a porous matrix can be calculated from the porosity.

The Reacting Flow in Porous Media, Transport of Concentrated Species interface treats concentrated reacting mixtures transported by a free and/or porous media flow. The component couplings between velocity field and mixture density are set up automatically. In addition, effective diffusion coefficients in a porous matrix can be calculated from the porosity.

**Single-Phase Flow**

The Laminar Flow interface is used primarily to model flow at low Reynold’s number often in combination with material transport and heat transfer. The
physics interface solves the Navier-Stokes equations and by default assumes that a flow can be compressible; that is, the density can depend on pressure, composition, and temperature. Compressible flow can be modeled in this physics interface at speeds of less than Mach 0.3. You can also choose to model incompressible flow and thereby simplify the equations to be solved.

Another useful tool is the ability to describe other material properties such as density and viscosity by entering equations that describe these terms as a function of other parameters such as material concentration, pressure, or temperature. Many materials in the material libraries use temperature- and pressure-dependent property functions.

**Porous Media and Subsurface Flow**

The Darcy’s Law interface is used to model fluid movement through interstices in a porous medium where a homogenization of the porous and fluid media into a single medium is done. Together with the continuity equation and equation of state for the pore fluid (or gas) this physics interface can be used to model flows for which the pressure gradient is the major driving force. The penetration of reacting gases through a catalytic washcoat or membrane is a classic example for the use of Darcy’s Law.

Darcy’s law can be used in porous media where the fluid is mostly influenced by the frictional resistance within the pores. Its use is within very low flows, or media where the porosity is relatively small. Where the size of the interstices are larger, and the fluid is also influenced by itself, the kinetic potential from fluid velocity, pressure, and gravity must be considered. This is done in the Brinkman Equations interface. Fluid penetration of filters and packed beds are applications for this physics interface.

The Brinkman Equations interface is used to model compressible flow at speeds of less than Mach 0.3. You can also choose to model incompressible flow and simplify the equations to be solved. Furthermore, you can select the Stokes-Brinkman flow feature to reduce the equations’ dependence on inertial effects.

The Brinkman Equations interface extends Darcy’s law to describe the dissipation of the kinetic energy by viscous shear, similar to the Navier-Stokes equation. Consequently, they are well-suited to transitions between slow flow in porous media, governed by Darcy’s law, and fast flow in channels described by the Navier-Stokes equations. The equations and boundary conditions that describe these types of phenomena are in the Free and Porous Media Flow interface. The Brinkman Equations interface can also add a Forchheimer drag term, which is a viscous drag on the porous matrix proportional to the square of the flow velocity.
The Free and Porous Media Flow interface is useful for equipment that contain domains where free flow is connected to porous media, such as packed-bed reactors and catalytic converters. It should be noted that if the porous region is large in comparison to the free fluid region, and you are not primarily interested in results in the region of the interface, then you can always couple a fluid flow interface to the Darcy’s Law interface, to make your overall model computationally cheaper.

The Free and Porous Media Flow interface is used over at least two differing domains, a free channel and a porous medium. The interface adds functionality that allows the equations to be optimized according to the definition of the material properties of the relevant domain. For example, you can select the Stokes-Brinkman flow feature to reduce the equations’ dependence on inertial effects in the porous domain, or just the Stoke’s flow feature to reduce the equations’ dependence on inertial effects in the free channel.

Compressible flow can also be modeled in this interface at speeds of less than Mach 0.3. You can also choose to model incompressible flow and thereby simplify the equations to be solved. As always, the physics interface gives you direct access to defining, with either constants or expressions, the material properties that describe the porous media flow. This includes the density, dynamic viscosity, permeability, porosity, and matrix properties.

HEAT TRANSFER

The various Heat Transfer interfaces include Heat Transfer in Fluids, Heat Transfer in Solids, and Heat Transfer in Porous Media, and account for conductive and convective heat transfer. These features interact seamlessly and can be used in combination in a single model. Surface-to-surface radiation can also be included in the energy equation, although this requires a license for the Heat Transfer Module.

The Physics Interface List by Space Dimension and Study Type

The table lists the physics interfaces available with this module in addition to those included with the COMSOL basic license.

<table>
<thead>
<tr>
<th>PHYSICS INTERFACE</th>
<th>ICON</th>
<th>TAG</th>
<th>SPACE DIMENSION</th>
<th>PRESET STUDY TYPE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chemical Species Transport</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Surface Reactions</td>
<td></td>
<td>chsr</td>
<td>all dimensions</td>
<td>stationary; time dependent</td>
</tr>
</tbody>
</table>

10 | Chemical Reaction Engineering Module Interfaces
<table>
<thead>
<tr>
<th>PHYSICS INTERFACE</th>
<th>ICON</th>
<th>TAG</th>
<th>SPACE DIMENSION</th>
<th>PRESET STUDY TYPE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transport of Diluted Species*</td>
<td>![icon]</td>
<td>chds</td>
<td>all dimensions</td>
<td>stationary; time dependent</td>
</tr>
<tr>
<td>Transport of Concentrated Species</td>
<td>![icon]</td>
<td>chcs</td>
<td>all dimensions</td>
<td>stationary; time dependent</td>
</tr>
<tr>
<td>Nernst-Planck Equations</td>
<td>![icon]</td>
<td>chnp</td>
<td>all dimensions</td>
<td>stationary; time dependent</td>
</tr>
<tr>
<td>Species Transport in Porous Media</td>
<td>![icon]</td>
<td>chpm</td>
<td>all dimensions</td>
<td>stationary; time dependent</td>
</tr>
<tr>
<td>Reaction Engineering</td>
<td>![icon]</td>
<td>re</td>
<td>0D</td>
<td>time dependent; stationary plug flow</td>
</tr>
</tbody>
</table>

**Reacting Flow**

Laminar Flow  

Transport of Concentrated Species  

Transport of Diluted Species  

**Reacting Flow in Porous Media**

**Fluid Flow**

Single-Phase Flow  

**Porous Media and Subsurface Flow**

Brinkman Equations  

Darcy’s Law  

Chemical Reaction Engineering Module Interfaces |
<table>
<thead>
<tr>
<th>PHYSICS INTERFACE</th>
<th>ICON</th>
<th>TAG</th>
<th>SPACE DIMENSION</th>
<th>PRESET STUDY TYPE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Free and Porous Media Flow</td>
<td><img src="image" alt="fp" /></td>
<td>fp</td>
<td>3D, 2D, 2D axisymmetric</td>
<td>stationary; time dependent</td>
</tr>
<tr>
<td><strong>Heat Transfer</strong></td>
<td><img src="image" alt="ht" /></td>
<td>ht</td>
<td>all dimensions</td>
<td>stationary; time dependent</td>
</tr>
<tr>
<td>Heat Transfer in Fluids*</td>
<td><img src="image" alt="ht" /></td>
<td>ht</td>
<td>all dimensions</td>
<td>stationary; time dependent</td>
</tr>
<tr>
<td>Heat Transfer in Porous Media</td>
<td><img src="image" alt="ht" /></td>
<td>ht</td>
<td>all dimensions</td>
<td>stationary; time dependent</td>
</tr>
</tbody>
</table>

* This is an enhanced physics interface, which is included with the base COMSOL package but has added functionality for this module.
The Model Libraries Window

To open a Chemical Reaction Engineering Module model library model, click Blank Model in the New screen. Then on the Home or Main toolbar click Model Libraries \(\Rightarrow\). In the Model Libraries window that opens, expand the Chemical Reaction Engineering Module folder and browse or search the contents.

Click Open Model \(\Rightarrow\) to open the model in COMSOL Multiphysics or click Open PDF Document \(\Rightarrow\) to read background about the model including the step-by-step instructions to build it. The MPH-files in the COMSOL model library can have two formats—Full MPH-files or Compact MPH-files.

- **Full MPH-files**, including all meshes and solutions. In the Model Libraries window these models appear with the \(\Rightarrow\) icon. If the MPH-file’s size exceeds 25MB, a tip with the text “Large file” and the file size appears when you position the cursor at the model’s node in the Model Libraries tree.

- **Compact MPH-files** with all settings for the model but without built meshes and solution data to save space on the DVD (a few MPH-files have no solutions for other reasons). You can open these models to study the settings and to mesh and re-solve the models. It is also possible to download the full versions—with meshes and solutions—of most of these models when you update your model library. These models appear in the Model Libraries window with the \(\Rightarrow\) icon. If you position the cursor at a compact model in the Model Libraries window, a No solutions stored message appears. If a full MPH-file is available for download, the corresponding node’s context menu includes a Download Full Model item \(\Rightarrow\).

To check all available Model Libraries updates, select Update COMSOL Model Library \(\Rightarrow\) from the File>Help menu (Windows users) or from the Help menu (Mac and Linux users).

A model from the model library is used as the tutorial in this guide. Go to “Tutorial Example: NO Reduction in a Monolithic Reactor” starting on the next page.
Tutorial Example: NO Reduction in a Monolithic Reactor

This model is of a catalytic converter that removes nitrogen oxide from a car exhaust through the addition of ammonia. The example shows an application of the modeling strategy, described in “Chemical Reaction Engineering Simulations”, and demonstrates through a series of simulations how an understanding of this reactor and its system can be improved. To do this, it uses a number of the interfaces and features found in the Chemical Reaction Engineering Module.

Introduction

This example models the selective reduction of nitrogen oxide (NO) by a monolithic reactor in the exhaust system of an automobile. Exhaust gases from the engine pass through the channels of a monolithic reactor filled with a porous catalyst and, by adding ammonia (NH₃) to this stream, the NO can be selectively removed through a reduction reaction.

Yet, NH₃ is also oxidized in a parallel reaction, and the rates of the two reactions are affected by temperature as well as composition. This means that the amount of added NH₃ must exceed the expected amount of NO, while not being so excessive as to release NH₃ to the atmosphere.

The goal of the simulations are to find the optimal dosing of NH₃, and to investigate some of the other operating parameters in order to gauge their effects.

Figure 4: Catalytic converters reduce the NOx levels in the exhaust gases emitted by combustion engines.
You may want to revisit the flowchart on page 3 to follow the modeling strategy for this model as described next. First, the selectivity aspects of the kinetics are studied by modeling initial reaction rates as function of temperature and relative reactant amounts. Information from these studies point to the general conditions required to attain the desired selectivity.

The reactor is then simplified and modeled as a non-isothermal plug flow reactor. This reveals the necessary NH$_3$ dosing levels based on the working conditions of the catalytic converter and assumed flow rate of NO in the exhaust stream. A 3D model of the catalytic converter is then set up and solved. This includes mass transport, heat transfer, and fluid flow and provides insight and information for optimizing the dosing levels and other operational parameters.

**Chemistry**

Two parallel reactions occur in the V$_2$O$_5$/TiO$_2$ washcoat of the monolithic reactor. The desired reaction is NO reduction by ammonia:

$$4\text{NO} + 4\text{NH}_3 + \text{O}_2 \rightarrow 4\text{N}_2 + 6\text{H}_2\text{O} \quad (5)$$

However, ammonia can at the same time undergo oxidation:

$$4\text{NH}_3 + 3\text{O}_2 \rightarrow 2\text{N}_2 + 6\text{H}_2\text{O} \quad (6)$$

The heterogeneous catalytic conversion of NO to N$_2$ is described by an Eley-Rideal mechanism. A key reaction step involves the reaction of gas-phase NO with surface-adsorbed NH$_3$. The following rate equation (mol/(m$^3$.s)) has been suggested in Ref. 1 for Equation 5:

$$r_1 = k_1c_{\text{NO}} \frac{a c_{\text{NH}_3}}{1 + a c_{\text{NH}_3}} \quad (7)$$

where

$$k_1 = A_1 \exp\left(\frac{E_1}{R_g T}\right)$$

and

$$a = A_0 \exp\left(\frac{E_0}{R_g T}\right)$$

For Equation 6, the reaction rate (mol/(m$^3$.s)) is given by

$$r_2 = k_2c_{\text{NH}_3} \quad (8)$$

where
Investigating the Chemical Reaction Kinetics

The competing chemical reactions, given by Equation 5 and Equation 6, raise the issue of optimal dosing of NH₃ to handle the reduction process. Stoichiometry suggests a 1:1 ratio of NH₃ to NO as a lower limit. It is likely that a stoichiometric excess of NH₃ is necessary but, at the same time, unnecessarily high levels of NH₃ in the gas stream leaving the catalytic converter need to be avoided.

Analyzing the kinetics can help identify conditions favoring the desirable reduction reaction. A first study looks at the initial reaction rates of the reduction and oxidation reactions as a function of temperature and relative amounts of reactants. Figure 9 shows initial rates for the reduction reaction (Equation 5). The curves represent a set of NH₃:NO ratios ranging from 1 to 2. The concentration of NO in the exhaust gas entering the catalytic converter is known to be 41.1 mmol/m³.

\[
k_2 = A_2 \exp\left(-\frac{E_{\text{a}}}{R_g T}\right)
\]

The rate of NO reduction goes through a maximum and falls off at higher temperatures. Higher NH₃ concentrations in the gas phase lead to increased levels of surface-adsorbed NH₃, in turn favoring the conversion of gas-phase NO to N₂. This explains the shifts of the rate maximum towards higher temperatures as the

![Figure 9: Initial reaction rates of the NO reduction reaction \( (r_1) \) as a function of temperature. The NH₃:NO ratio ranges from 1 to 2.](image)
NH$_3$:NO ratio increases. The decrease in the NO reduction rate at the highest temperatures is explained by the desorption rate of NH$_3$ from the catalyst surface becoming faster than the reaction of adsorbed NH$_3$ with gas-phase NO. According to Equation 8, the ammonia oxidation rate increases with temperature and NH$_3$ concentration. Figure 10 shows the selectivity parameter, defined as:

$$ S = \frac{r_1}{r_2} $$

A value greater than one means that NO reduction is favored, while a value of less than one means NH$_3$ oxidation is the preferred reaction pathway. Clearly the selectivity for NO reduction drops both with increasing temperature and increasing NH$_3$:NO ratio.

![Figure 10: Selectivity parameter (r$_1$/r$_2$) as a function of temperature. The NH$_3$:NO ratio ranges from 1 to 2.](image)

The kinetic analysis suggests that preferred working conditions involve moderate temperatures and relatively low ratios of NH$_3$:NO.

**Investigating a Plug Flow Reactor**

To find the minimal level of NH$_3$ required to reduce the NO present in the exhaust gas requires a reactor model accounting for changing reactant concentrations and system temperature. From a mass transfer point of view, channels of the reactor monolith can be considered to be uncoupled to one another. Therefore, it is reasonable to perform initial simulations where a single
reactive channel, modeled by nonisothermal plug flow equations, represents the monolith reactor.

This model is set up and solved using the Reaction Engineering interface.

**Model Equations**

Assuming steady-state, the mass balance equation for a plug flow reactor is given by:

\[
\frac{dF_i}{dV} = R_i
\]

where \( F_i \) is the species molar flow rate (mol/s), \( V \) represents the reactor volume (m\(^3\)), and \( R_i \) the species net reaction rate (mol/(m\(^3\)·s)). The energy balance for the ideal reacting gas is:

\[
\sum_i F_i C_{p,i} \frac{dT}{dV} = Q_{\text{ext}} + Q
\]

(11)

where \( C_{p,i} \) is the species molar heat capacity (J/(mol·K)), and \( Q_{\text{ext}} \) is the heat added to the system per unit volume (J/(m\(^3\)·s)). \( Q \) denotes the heat due to chemical reaction (J/(m\(^3\)·s)).

\[
Q = -\sum_j H_j r_j
\]

where \( H_j \) the heat of reaction (J/mol), and \( r_j \) the reaction rate (mol/(m\(^3\)·s)).

The reactor equations are solved for a channel 0.36 m in length with a cross sectional area of 12.6 mm\(^2\). It is assumed that exhaust gas containing 41.1 mmol/m\(^3\) of NO at a temperature of 523 K passes through the channel at 0.3 m/s.

**Results**

The plot in Figure 12 shows the molar flow rate of NH\(_3\) as function of position in the reactor. The set of lines represent NH\(_3\):NO ratios ranging from 1 to 2. Under
these conditions results show that a NH$_3$:NO ratio of at least 1.3 is needed to guarantee that NH$_3$ is available as a reductive agent throughout the entire reactive channel.

Figure 12: Molar flow rate (mol/s) of NH$_3$ as function of channel volume.
Settling at NH$_3$:NO ratio of 1.35 generates the flow rate and temperature profiles in the single channel model as shown in Figure 13 and Figure 14.

The conversions of NO and NH$_3$ of are 98.7% and 97.2%, respectively.

---

**Figure 13:** Molar flow rates (mol/s) of NO and NH$_3$ as function of channel volume.

**Figure 14:** Reactor temperature (K) as function of channel volume.
Results show a moderate temperature increase for the given dosing level, which is desirable from a selectivity point of view. A plot of the selectivity parameter in Figure 15 confirms that NO reduction is favored in the entire channel \((2.3 < S < 3.4)\).

**Figure 15:** Selectivity parameter \((r_1/r_2)\) as a function of channel volume.

**Investigating a 3D Reactor**

It is clear from the kinetic analysis as well as from the single channel model that temperature plays a central role in affecting the optimal dosing of NH\(_3\). As the temperature distribution is likely to vary from channel to channel in a catalytic converter, a full 3D reactor model is required.

**Model Geometry**

The monolithic reactor has a modular structure made up of monolith channel blocks and supporting solid walls. The reactor is 0.36 m long with a 0.1 m radius.
Each reactive channel has a cross sectional area of 12.6 mm$^2$, and in a channel block the void fraction is 0.75.

**Model Equations and Assumptions**

In this example a pseudo homogeneous approach is used to model the hundreds of channels present in the monolith reactor. As no mass is exchanged between channels, each channel is described by 1D mass transport equations. Furthermore, fully developed laminar flow in the channels is assumed, such that the average flow field is proportional to the pressure difference across the reactor. The fluid flow transports mass and energy only in the channel direction. The energy equation describes the temperature of the reacting gas in the channels, as well as the conductive heat transfer in the monolith structure and the supporting walls. As the temperature affects not only the reaction kinetics but also the density and viscosity of the reacting gas, the energy equation is what really connects the channels in the reactor structure turning this into a 3D model.

**Mass Transport**

The mass balances describing transport and reaction in the reacting channels are given by diffusion-convection equations at steady state:

$$\nabla \cdot (-D_i \nabla c_i) + \mathbf{u} \cdot \nabla c_i = R_i$$  \hspace{1cm} (17)
In Equation 17, $D_i$ denotes the diffusion coefficient (m$^2$/s), $c_i$ is the species concentration (mol/m$^3$), and $\mathbf{u}$ equals the velocity vector (m/s). The term $R_i$ (mol/(m$^3$·s)) corresponds to the species’ rate expression.

Mass transport is only allowed in the direction of the channels, corresponding to direction of the $x$-axis in the 3D geometry used in this example. For the diffusive transport, this is accomplished by setting the $y$ and $z$-components of the diffusivity matrix to zero. The pressure-driven flow in the monolith is also defined in the direction of the $x$-axis, hereby restricting the convective mass transport to the channel direction as well. Each monolith channel thus behaves as a 1D plug flow model with included diffusion. These separate channel models are connected through the heat transfer equations for the reactor monolith.

**Fluid Flow**

Assuming there is fully developed laminar flow in the channels, the average flow field is proportional to the pressure difference across the reactor. The flow of reacting gas through the monolith can then be modeled using a Darcy’s Law interface with the following governing equations:

$$\nabla \cdot (\rho \mathbf{u}) = 0$$

$$\mathbf{u} = \frac{\kappa}{\mu} \nabla p$$

The monolith is treated as a porous matrix with the effective permeability $\kappa$ (m$^2$).

**Heat Transfer**

A single temperature equation describing the heat transfer in the porous monolith reactor can be written as:

$$(\rho C_{p,T}) \frac{\partial T}{\partial t} + \rho_f C_{p,f} \mathbf{u} \cdot \nabla T = \nabla \cdot (k_{eq} \nabla T) + Q$$

For the stationary case this reduces to:

$$\rho_f C_{p,f} \mathbf{u} \cdot \nabla T = \nabla \cdot (k_{eq} \nabla T) + Q$$

where $\rho_f$ (kg/m$^3$) is the fluid density, $C_{p,f}$ (J/(kg·K)) is the fluid heat capacity, and $k_{eq}$ (W/(m·K)) is the equivalent thermal conductivity. Furthermore, $\mathbf{u}$ (m/s) is the fluid velocity field, which in this model is calculated in the Darcy’s Law interface, and $Q$ (W/m$^3$) is the heat source, which is due to exothermic chemical reactions:

$$Q = Q_1 + Q_2 = -r_1H_1 - r_2H_2$$
The equivalent conductivity of the solid-fluid system, $k_{eq}$, is related to the conductivity of the solid, $k_p$, and to the conductivity of the fluid, $k_f$, by:

$$k_{eq} = \Theta_p k_p + \Theta_f k_f$$  \hspace{1cm} (20)

In Equation 20, $\Theta_p$ denotes the solid material’s volume fraction, here 0.25, which is related to the volume fraction of the fluid $\Theta_f$ by:

$$\Theta_f + \Theta_p = 1$$

Equation 19 is the equation set up by the Heat Transfer interface for a fluid domain. For the supporting walls in the reactor, only heat transfer by conduction applies:

$$-\nabla \cdot (k_s \nabla T) = 0$$

where $k_s$ (W/(m·K)) is the thermal conductivity for the solid walls.

As mentioned, the temperature affects not only reaction kinetics but also the density and viscosity of the reacting gas. In this way the heat transfer equation connects the channels in the reactor structure.

**Thermodynamic and Transport Properties**

Accurate thermodynamic data is required as input to energy balance equations, both in the plug flow model (Equation 11) and the 3D monolith model (Equation 19). The module uses the following set of polynomials as default expressions describing species thermodynamic properties:

$$C_{p,i} = R_g a_1 + a_2 T + a_3 T^2 + a_4 T^3 + a_5 T^4$$  \hspace{1cm} (21)

$$h_i = R_g \left( a_1 T + \frac{a_2 T^2}{2} + \frac{a_3 T^3}{3} + \frac{a_4 T^4}{4} + \frac{a_5 T^5}{5} + a_6 \right)$$  \hspace{1cm} (22)

$$s_i = R_g \left( a_1 \ln T + a_2 T + \frac{a_3 T^2}{2} + \frac{a_4 T^3}{3} + \frac{a_5 T^4}{4} + a_7 \right)$$  \hspace{1cm} (23)

Here, $C_{p,i}$ denotes the species’ heat capacity (J/(mol·K)), $T$ the temperature (K), and $R_g$ the ideal gas constant, 8.314 (J/(mol·K)). Further, $h_i$ is the species’ molar enthalpy (J/mol), and $s_i$ represents its molar entropy (J/(mol·K)). A set of seven coefficients per species are taken as input for the polynomials above. The coefficients $a_1$ through $a_5$ relate to the species heat capacity, the coefficient $a_6$ is associated with the species enthalpy of formation (at 0 K), and the coefficient $a_7$ comes from the species entropy of formation (at 0 K).

The equation form outlined by Equation 21 through Equation 23 is referred to as CHEMKIN or NASA format (Ref. 2). Database resources list the needed
coefficients for different temperature intervals (Ref. 3). In this example, files with thermodynamic coefficients are read into the software such that the predefined thermodynamic property expressions can be used directly.

In addition to thermodynamic properties, the model equations also require transport properties to accurately describe the space dependent reactor model. For instance, the mass transport (Equation 17) need species specific diffusion coefficients as input.

For reacting gas mixtures, the Reaction Engineering interface makes use of kinetic gas theory to set up expressions for transport properties such as diffusivities, viscosity, and thermal conductivity as functions of temperature, pressure, and composition. In this example, the species diffusivities ($m^2/s$) are calculated using the formula

$$D = 2.695 \cdot 10^{-3} \cdot \frac{3 \cdot T^3 ((M_A + M_B)/(2 \cdot 10^3 M_A M_B))}{\rho \sigma_A \sigma_B \Omega_D}$$

(24)

where $\Omega_D$ is a collision integral

$$\Omega_D = f(T, \sigma, \frac{\varepsilon}{k_b}, \mu_D)$$

To evaluate Equation 24 you need to specify the characteristic length and energy minimum of the Lennard-Jones interaction potential, that is $\sigma$ ($10^{-10}$ m) and $\varepsilon/k_b$ (K), respectively. The species dipole moment, $\mu_D$ (Debye), can also be provided. Each species in the reacting gas has a characteristic set of these constants, and you find their values in the literature, in databases, or from experiments. The parameters $\sigma$, $\varepsilon/k_b$, and $\mu_D$ can either be entered manually in the Reaction Engineering interface, or you can import text files containing the data, as is done in this example.

The data parameters used for this model have been compiled from Ref. 4 and are summarized below:

<table>
<thead>
<tr>
<th>SPECIES</th>
<th>$\sigma$ (Å)</th>
<th>$\varepsilon/k_b$ (K)</th>
<th>$\mu_D$ (D)</th>
</tr>
</thead>
<tbody>
<tr>
<td>H2O</td>
<td>809.1</td>
<td>2.640</td>
<td>1.8</td>
</tr>
<tr>
<td>N2</td>
<td>71.4</td>
<td>3.798</td>
<td>0.0</td>
</tr>
<tr>
<td>NH3</td>
<td>558.3</td>
<td>2.900</td>
<td>1.5</td>
</tr>
<tr>
<td>NO</td>
<td>116.7</td>
<td>3.492</td>
<td>0.2</td>
</tr>
<tr>
<td>O2</td>
<td>106.7</td>
<td>3.467</td>
<td>0.0</td>
</tr>
</tbody>
</table>
RESULTS

The plot in Figure 25 shows the conversion of NO in the monolith channel blocks. The average conversion at the outlet is 97.5%. This is somewhat lower than the 98.7% conversion predicted by the single channel model. The isosurfaces in the plot show how a channel’s performance depends on its position in the reactor, clearly pointing to the 3D nature of the problem.

![Figure 25: Isosurfaces showing the conversion of NO in the reactor.](image)

The individual channels, although they do not exchange mass, are connected through the temperature distribution in the reactor. The temperature affects both the flow velocity of the reacting gas as well as the reaction rates. Cross sections of
the reactor temperature are shown in Figure 26.

Figure 26: Temperature distribution in cross sections of the reactor.

The exothermic reactions increase the temperature in the central parts of the reactor, while the temperature is decreased through heat loss to the surroundings. The maximum temperature calculated for the 3D reactor is 542 K, which is higher than for the single channel model, where $T_{\text{max}} = 533.9$ K. The effect of the relatively high thermal conductivity of the supporting walls is clearly visible.

A seen from the initial kinetic analysis, elevated temperatures have a detrimental effect on the selectivity, leading to ammonia getting oxidized (Equation 6) rather than be consumed in the NO reducing reaction (Equation 5). A plot of $r_1/r_2$ on the symmetry surface of the monolith is shown in Figure 27. The fact that $r_1/r_2$
is greater than 1 signals that the selectivity favors the desired reducing reaction in all regions of the reactor.

Figure 27: The fact that $r_1/r_2$ is greater than 1 signals that the selectivity favors the desired NO reducing reaction.

The selectivity plot once again reveals the space-dependent nature of the problem. Channels in the relatively cold region near the reactor outer surface display high selectivity throughout, whereas channels in the region close to the center see selectivity falling off comparatively fast. Compared to the single channel model, the 3D reactor shows notably lower values of the selectivity parameter near the center of the outlet. Nevertheless, NO reduction is still favored throughout.

The information from this 3D model can also be used to investigate other aspects of this reacting system. These results can be compared to other results from prototypes or even real monolith reactors, and material properties, such as the permeability constant, can be fine-tuned. Different operating conditions, such as when the automobile accelerates and decelerates, can be simulated. Alternate catalysts and designs can also be proven.

**Summary**

The Chemical Reaction Engineering Module is used to perform three different analyses concerning the reduction of NO in a monolithic reactor:

1. Kinetic analysis—to explore the system of competing reactions and learn what conditions that promote selectivity towards NO reduction.
Plug flow reactor model—to explore the coupled mass and energy balance equations in a single channel model, resulting in a first estimate of the NH$_3$ dosing level.

3D reactor model—testing the reactor operating conditions in a full 3D reactor representation, noting the space-dependent effect due to coupling between monolith channels.

A reactant ratio NH$_3$:NO of approximately 1.35 is found to be close to optimal under the investigated conditions. This ratio leads to minimal waste of ammonia without limiting the NO reduction chemistry. It also favors the selectivity for NO reduction while at the same time restricting the possible heat evolved through the chemical reactions. This in turn helps control the temperature in the reactor, again favoring the NO reduction.

The modeling strategy used in this example has several advantages. Starting with fast simulations using easy to set up models makes it easier to identify and narrow down the process condition envelope before moving to more advanced and computationally demanding models. The sequential modeling approach also helps to identify when and how effects such as temperature dependency and space dependency come into play. This deepened system understanding leads to efficient model set up and solution strategies. Going from perfectly mixed conditions to full space dependency in 3D also puts you in the position to decide on what level of detail that is needed for the particular system.

**References**


3. This example uses data from the GRI-Mech 3.0. [www.me.berkeley.edu/gri-mech](http://www.me.berkeley.edu/gri-mech)


**Note on the Reactor Models**
The following step-by-step instructions guide you through the process to set up and solve two models that simulate the catalytic reduction of NO in a monolith reactor. First, a plug flow reactor model is used to simulate the non-isothermal chemistry taking place in a single monolith channel. The second model accounts...
for the full 3D monolith reactor, coupling mass transport to heat transfer and fluid flow.

As an option, you can open the completed model file of the plug flow reactor model and proceed directly with the set up of the 3D reactor model. See “Generate Space-Dependent Model” on page 39 for further details.

Instructions on how to set up and solve the model used for the kinetic analysis are provided in the documentation for the model monolith_kinetics.mph. See “The Model Libraries Window” on page 13 for information about how to open this file.

**Model Wizard**

**Note:** These instructions are for the user interface on Windows but apply, with minor differences, also to Linux and Mac.

1. To start the software, double-click the COMSOL icon on the desktop. When the software opens, you can choose to use the Model Wizard to create a new COMSOL model or Blank Model to create one manually. For this tutorial, click the Model Wizard button.

   If COMSOL is already open, you can start the Model Wizard by selecting **New** from the File menu and then click **Model Wizard**.

   The Model Wizard guides you through the first steps of setting up a model. The next window lets you select the dimension of the modeling space.

2. In the **Space Dimension** window click the **ODE 0D** button.

3. In the Select Physics tree under Chemical Species Transport, double-click **Reaction Engineering (re)** to add it to the Added physics list. You can also right-click and choose **Add Selected**.

4. Click **Study**. In the Select Study tree under Preset Studies, click **Stationary Plug Flow**.

5. Click **Done**.

**Rename Component 1**

1. In the Model Builder, right-click Component 1 and choose Rename (or press F2).

2. Go to the Rename Component dialog box and enter **Channel Model** in the New name field. Click OK.
Definitions - Parameters and Variables

Start by importing a set of global Parameters defining the process conditions for the monolith reactor, including the dimensions of the reactive channels, the flow rate of the reacting gas, and the temperature conditions. Then import the Variables for model specific expressions defining rate constants and the selectivity parameter $S$.

**Note:** The location of the files used in this exercise varies based on the installation. For example, if the installation is on your hard drive, the file path might be similar to `C:\Program Files\COMSOL44\models`.

**Parameters**

1. On the Home toolbar click **Parameters** \( P_1 \). You can also do this by going to the Model Builder, right-clicking Global Definitions \( \equiv \) and selecting Parameters \( P_1 \).

**Note:** On Linux and Mac, the Home toolbar refers to the specific set of controls near the top of the Desktop.

2. In the Parameters settings window under Parameters, click the Load from File button \( \equiv \).

3. Browse to the file `monolith_3d_parameters.txt` in the model library folder on your computer, `Chemical_Reaction_Engineering_Module\Heterogeneous_Catalysis`. Double-click to add or click Open.

The parameters are added to the table.

**Variables**

1. In the Home toolbar, click Variables \( \equiv \) and select Local variables. You can also go to the Model Builder under Channel Model, right-click Definitions \( \equiv \) and select Variables \( \equiv \).
2 In the Variables settings window under Variables, click the Load from File button.

3 Browse to the file `monolith_3d_variables.txt` in the model library folder on your computer, `Chemical_Reaction_Engineering_Module\Heterogeneous_Catalysis`. Double-click to add or click Open.

The variables are added to the table.

**Note:** The orange-colored expression in the variables list indicates inconsistent units. Once the temperature equation is added the unit error is fixed.

### Reaction Engineering Interface

Now it is time to define the chemical reactions. First, enter the reaction formula for NO reduction. The Reaction Engineering interface automatically interprets the reaction formula and suggests a reaction rate based on the mass action law.

**Reaction 1**

1 On the Physics toolbar, click Global, and select Reaction. As an alternative, you can also go to the Model Builder, right-click Reaction Engineering (re) and select Reaction.

2 In the Reaction settings window under Reaction Formula, enter (or copy and paste) `4NO + 4NH3 + O2 => 4N2 + 6H2O` in the Formula edit field.

**Note:** Clicking anywhere in the Model Builder generates the new Reaction node. Species features associated with the reaction are also generated automatically.

In this example, replace the automatically generated reaction rate expression with the rate expression known in the literature.
3 In the Model Builder click the 1:4NO+4NH3+O2=>4N2+6H2O node.

In the Reaction settings window under Reaction Rate, Select User defined from the Reaction Rate list, then enter (or copy and paste)
\[ k_1 \cdot c_{\text{NO}} \cdot a \cdot c_{\text{NH3}} \left(1 + a \cdot c_{\text{NH3}}\right) \] in the Reaction rate \( (r) \) edit field.

4 In the Reaction settings window under Reaction Rate, Select User defined from the Reaction Rate list, then enter (or copy and paste)
\[ 4NH3+3O2=>2N2+6H2O \] in the Formula edit field.

Locate the Reaction Rate section. Select User defined from the Reaction Rate list, then enter \( k_2 \cdot c_{\text{NH3}} \) in the Reaction rate \( (r) \) edit field.

After setting up the reaction kinetics, define the reactor model where the chemistry takes place.

Using the Reaction Engineering node you can select one of the predefined reactor types. In this case, select a non-isothermal plug flow reactor to represent a reactive channel in the monolith.

1 In the Model Builder, click the Reaction Engineering (re) node.
2 In the Reaction Engineering settings window under Reactor Settings:
   - Select Plug flow from the Reactor type list.
   - Select the Calculate thermodynamic properties and Calculate transport properties check boxes.
3 Under General in the Temperature ($T$) field, enter $T_{\text{in}}$.
4 Under Mass Balance in the Volumetric flow rate ($v$) edit field, enter $v_{\text{av}}A$.

The Reaction Engineering interface can set up predefined expressions for species transport and thermodynamic properties. Thermodynamic property expressions follow the NASA polynomial format while transport property expressions are based on the kinetic gas theory. Input files can be imported into the software supplying all necessary input parameters for the expressions.

The thermodynamic expressions enter the energy balance of the plug flow reactor. The transport expressions, for instance describing species diffusivity coefficients, are used in the 3D monolith model set up later on.

1 In the Model Builder, click the Reaction Engineering (re) node.
2 In the Reaction Engineering settings window click to expand the CHEMKIN section.
3 Click the Browse button under Thermo input file, select All files (*.*) and browse to the file `monolith_3d_thermo.txt` in the model library folder `Chemical_Reaction_Engineering_Module\Heterogeneous_Catalysis`.
4 Double-click to add or click Open.
5 Click Import.
6 Click the Browse button under Transport input file, select All files (*.*) , and browse to the file monolith_3d_transport.txt in the same model library folder as in step 3.
7 Double-click to add or click Open.
8 Click Import.

At this point you have set up the reaction kinetics and chosen a plug flow reactor to model NO reduction in a monolith channel.

In the next step, define the species molar flow rates at the reactor inlet.

1 In the Model Builder, click each Species node one at a time (Species: NO, Species: NH₃, Species: O₂, Species: N₂, and Species: H₂O).
2 In each species node’s settings, expand the Species Feed Stream section and enter the values according to the table below into the Inlet molar flow (F₀) field. See the previous figure for an example for the NO species node.

<table>
<thead>
<tr>
<th>SPECIES NODE</th>
<th>INLET MOLAR FLOW (F₀) VALUE</th>
</tr>
</thead>
<tbody>
<tr>
<td>NO</td>
<td>1.55e-7 [mol/s]</td>
</tr>
<tr>
<td>NH₃</td>
<td>2.1e-7 [mol/s]</td>
</tr>
<tr>
<td>O₂</td>
<td>2.71e-6 [mol/s]</td>
</tr>
<tr>
<td>N₂</td>
<td>6.86e-5 [mol/s]</td>
</tr>
<tr>
<td>H₂O</td>
<td>7.34e-6 [mol/l/s]</td>
</tr>
</tbody>
</table>

Species: N₂
1 Click the Species: N₂ node .
In the Species settings window under Species Formula, select Solvent as the Species type.

\( \text{N}_2 \) is the dominant species in the reacting mixture and its concentration can be treated as constant. Assigning this species as a Solvent removes the associated mass balance. Also, automatically generated model expressions assume that the physical properties of the reacting mixture are the same as the properties of \( \text{N}_2 \).

**Energy Balance**

Finalize the set up of the non-isothermal plug flow reactor by adding an Energy Balance feature.

**Note:** All thermodynamic properties that go into the energy balance are automatically set up by the software. You only need to add values for the temperature at the inlet and heat transferred to the reactor surroundings.

1. Right-click Reaction Engineering (re) and select Energy Balance.

2. In the Energy Balance settings window under Energy Balance:
   - In the External heat source (\( Q_{\text{ext}} \)) field enter \((T_{\text{amb}} - T) \cdot UA\).
   - Enter \( T_{\text{in}} \) in the Initial temperature (\( T_0 \)) field.

**Study 1**

**Step 1: Stationary Plug Flow**

1. In the Model Builder, expand the Study 1 node and click Step 1: Stationary Plug Flow.

2. Go to the Stationary Plug Flow settings window. Under Study Settings:
   - Enter \( 0.36 \cdot A \) in the Volumes field.
   - Select the Relative tolerance check box and enter \( 1 \cdot 10^{-5} \) in the field.
**Solver 1**

1. On the Study toolbar click Show Default Solver.
2. Expand the Solver 1 node and click Plug Flow Solver 1.
3. In the Plug Flow Solver settings window, click to expand the Absolute Tolerance section. In the Tolerance field, enter $1e^{-6}$.
4. On the Home toolbar, click Compute.

---

**Results—Single Channel Model**

Follow these steps to generate result plots for the single channel model and display molar flow rates, temperature, and selectivity when the NH$_3$:NO ratio is 1.35 at the inlet.

**Flow Rate (re)**

1. In the Model Builder, under Results, expand the Flow Rate (re) node and click Global 1.
2. In the Global settings window under y-Axis Data, click the Replace Expression button. Select Reaction Engineering>Molar flow rate (comp1.re.F_NO) from the list.
3. Under y-Axis Data, click the Add Expression button. Select Reaction Engineering>Molar flow rate (comp1.re.F_NH3) from the list.
4. On the 1D plot group toolbar, click the Plot button. The same Global plot as in Figure 13 on page 20 displays in the Graphics window.
By default, the software generates a plot group Temperature (re). Click this node to see the temperature results as in the figure below (which is the same Global plot as in Figure 14 on page 20).

![Global Temperature (K)](image)

**1D Plot Group 3**
1. On the Home toolbar, click Add Plot Group and choose 1D Plot Group.
2. On the 1D plot group toolbar, click Global.
3. In the Global settings window under y-Axis Data, click the Replace Expression button. Select Definitions>Selectivity parameter (comp1.S) from the list.
4. On the 1D plot group toolbar, click the Plot button.

The Global plot in Figure 15 on page 21 is displayed in the Graphics window. The selectivity for the NO reduction reaction falls off in the second half of the reactor even though the decreasing temperature should favor this reaction. The reason for this is the relatively low ratio of NO to NH₃.
Note: The model so far is available from the model library under the folder Heterogeneous Catalysis. As an option, you can open the model file monolith_plugflow.mph from this folder and continue with the step-by-step instructions below.

In the next stage of the example, a 3D model of the monolithic reactor is set up, including reaction, mass transport, heat transfer, and fluid flow.

Generate Space-Dependent Model

The Generate Space-Dependent Model feature creates an active link between the plug flow channel model and the full 3D monolith model. It allows you to transfer reaction kinetics, thermodynamics, and transport properties set up in the Reaction Engineering interface to the physics interfaces describing space and time-dependent systems.

1. In the Model Builder, right-click Reaction Engineering (re) and select Generate Space-Dependent Model.
3. Select the Create inflow and outflow features check box.
4. Under Space-Dependent Model Generation, select the Enable space-dependent physics interfaces check box.

The Generate Space-Dependent Model feature creates a Component node in the Model Builder with the Transport of Diluted Species interface and the Heat Transfer in Fluids interface as child nodes.
Rename Component 2

1. In the Model Builder, click Component 2 and press F2.
2. Enter 3D Model in the New name field. Click OK.

Model Wizard

In addition to those physics interfaces set up by the Generate Space-Dependent Model feature, you can use the Model Wizard to add additional interfaces. For example, add a Darcy’s Law interface to model the flow through the porous channel blocks.

3. Click Add to Component.

A Darcy’s Law interface is added to the Model Builder.

Geometry

Use the Geometry node to import a file with the reactor geometry. Symmetry reduces the modeling domain to one eighth of the full monolith.

1. On the Home toolbar, click Import.
2. In the Import settings window under Import, click Browse.
3. Browse to the file monolith_3d.mphbin in the model library folder on your computer,
Definitions - Selections

A central part of the model set up consists of assigning features to domains and boundaries of the model geometry. The use of the Selection feature makes this process more efficient. These steps illustrate how to set up eight Explicit nodes and rename the geometric selections accordingly.
Explicit Selections

1. On the Definitions toolbar, click Explicit. Repeat this step and add eight (8) Explicit nodes. Or right-click the first Explicit node and select Duplicate seven times.

2. In the Model Builder click each Explicit node one at a time to open its settings window.

3. In the Explicit settings window under Input Entities, for each node select the Geometric entity level (domain or boundary as indicated in the table). Then press F2 and rename each node as indicated in the table.

<table>
<thead>
<tr>
<th>DEFAULT NODE NAME</th>
<th>SELECT THESE DOMAINS OR BOUNDARIES</th>
<th>NEW NAME FOR THE NODE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Explicit 1</td>
<td>domain 1 only</td>
<td>Supporting walls</td>
</tr>
<tr>
<td>Explicit 2</td>
<td>domains 2, 3, 4, 5, and 6</td>
<td>Channel blocks</td>
</tr>
<tr>
<td>Explicit 3</td>
<td>boundaries 4, 9, 13, 19, and 23</td>
<td>Inlet</td>
</tr>
<tr>
<td>Explicit 4</td>
<td>boundaries 30, 31, 32, 33, and 34</td>
<td>Outlet</td>
</tr>
<tr>
<td>Explicit 5</td>
<td>boundaries 2, 3, 6, 8, 15, and 18</td>
<td>Symmetry</td>
</tr>
<tr>
<td>Explicit 6</td>
<td>boundary 1 only</td>
<td>Inlet walls</td>
</tr>
<tr>
<td>Explicit 7</td>
<td>boundary 29 only</td>
<td>Outlet walls</td>
</tr>
<tr>
<td>Explicit 8</td>
<td>boundary 27 only</td>
<td>Reactor surface</td>
</tr>
</tbody>
</table>

Domain or boundaries can be assigned to the Explicit features by first left-clicking in the geometry and then confirming the selection with a right-click. This adds the identification number of the domain or boundary to the Input Entities list.

When you know the boundaries, you can also click the Paste button and enter the information. In this example for the Explicit 3 node, enter 4, 9, 13, 19, 23 in the Paste Selection window.

You will also create a selection that comprises all boundaries on the inlet end. Add a Union selection for this purpose.
On the Definitions toolbar, click Union.

In the Union settings window under Geometric Entity Level section, set the Level to Boundary.

Click the Add button under the Selections to add box in the Input Entities section.

In the Add dialog box that opens, Ctrl-click to choose Inlet and Inlet walls, then click OK.

Click the Union 1 node and press F2. Enter the New name as Inlet end, then click OK to close the dialog box. All the nodes under Definitions are now renamed as shown in this figure.

Materials

The next step is to specify material properties for the model. Ready-to-use materials can be selected from the available libraries. You can also define your own materials.
Material 1
1 On the Home toolbar, click Add Material .  
2 In the Add Material window, under Liquids and Gases>Gases, click Nitrogen .  
3 Click Add to Component.  
Assigning a material to selections in the geometry makes the physical properties of the material available to the physics interfaces.  

Nitrogen
1 In the Model Builder under Materials, click Nitrogen .  
2 In the Material settings window under Geometric Entity Selection, select Channel blocks from the Selection list.  
Next, create a user-defined material and associate it with the supporting walls.  

Material 2
1 On the Home toolbar, click New Material .  
2 Click Material 2 and press F2.  
3 Enter Walls in the New name field and click OK.  
4 In the Material settings window under Geometric Entity Selection, select Supporting walls from the Selection list.  

Walls
1 In the Model Builder under Materials, expand the Walls node and click Basic.
2 In the Property Group settings window under Output Properties and Model Inputs, expand the Quantities tree and under Output Properties select Density.

In the Property Group settings window under Output Properties and Model Inputs, expand the Quantities tree and under Output Properties select Density.

3 Right-click to Add or click the Add button † under the list.

4 In the Output properties table, enter the following settings:

<table>
<thead>
<tr>
<th>PROPERTY</th>
<th>VARIABLE</th>
<th>EXPRESSION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Density</td>
<td>rho</td>
<td>2970 [kg/m^3]</td>
</tr>
</tbody>
</table>

5 In the Quantities tree, select Output Properties>Heat Capacity at Constant Pressure.

6 Right-click to Add or click the Add button †.

7 In the Output properties table, enter the following settings:

<table>
<thead>
<tr>
<th>PROPERTY</th>
<th>VARIABLE</th>
<th>EXPRESSION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heat capacity at constant pressure</td>
<td>Cp</td>
<td>975 [J/kg/K]</td>
</tr>
</tbody>
</table>

8 In the Quantities tree, select Output Properties>Thermal Conductivity.

9 Right-click to Add or click the Add button †.

10 In the Output properties table, enter the following settings:

<table>
<thead>
<tr>
<th>PROPERTY</th>
<th>VARIABLE</th>
<th>EXPRESSION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thermal conductivity</td>
<td>(k1, ..., k33)</td>
<td>35 [W/m/K]</td>
</tr>
</tbody>
</table>
In the next stage of the model, the physics interfaces are set up to describe the mass transport, heat transfer, and fluid flow in the monolithic reactor.

In the Model Builder, click Collapse All button to get a better overview of the tree for the remainder of the model set up.

**Transport of Diluted Species Interface**

1. In the Model Builder under 3D Model, click Transport of Diluted Species 1 (chds).
2. In the Transport of Diluted Species settings window under Domain Selection, select Channel blocks from the Selection list.

*Convection and Diffusion 1*

Couple the mass transport to the fluid flow by selecting the Darcy’s Law velocity field as Model Inputs.

1. In the Model Builder, expand the Transport of Diluted Species 1 (chds) node and click the Convection and Diffusion 1 node . The ‘D’ in the upper left corner of a node means it is a default node.
2. In the Convection and Diffusion settings window under Model Inputs, select Darcy’s velocity field (dl/dlm1) from the list.

The mass transport model for the monolith channels assumes that there is only diffusive mass transport in the axial direction of the reactor, here, along the x-axis. This can be accomplished by specifying the diffusivity only in the first element of the diagonal diffusion matrix.
Note also the variables predefined in the Diffusion coefficient fields, corresponding to diffusivity expressions set up by the Generate-Space Dependent Model feature.

Fill in the tables under Diffusion as indicated in the next steps.

1. From the $D_{NO}$ Diffusion coefficient list, select Diagonal. In the table, delete the $yy$ and $zz$ entries and enter these settings:

```
root.comp1.re.D_NO
    0   0
```

2. From the $D_{NH3}$ Diffusion coefficient list, select Diagonal. In the table, delete the $yy$ and $zz$ entries and enter these settings:

```
root.comp1.re.D_NH3
    0   0
```

3. From the $D_{O2}$ Diffusion coefficient list, select Diagonal.

4. In the table, delete the $yy$ and $zz$ entries and enter these settings:

```
root.comp1.re.D_O2
    0   0
```

5. From the $D_{H2O}$ Diffusion coefficient list, select Diagonal.

6. In the table, delete the $yy$ and $zz$ entries and enter these settings:

```
root.comp1.re.D_H2O
    0   0
```
The Diffusion section should now look as follows:

![Diffusion Table]

The features defining reaction rates and inlet concentrations were set up during the Generate-Space Dependent Model procedure. Definitions correspond to the reactor conditions specified for the plug flow channel model. All you have to do is to make sure the features are assigned to the proper domains and boundaries of the 3D reactor.

**Inflow 1**
1. In the Model Builder under Transport of Diluted Species 1, click Inflow 1.
2. In the Inflow settings window, select Inlet from the Selection list.

**Outflow 1**
1. In the Model Builder, click Outflow 1.
2. In the Outflow settings window under Boundary Selection, select Outlet from the Selection list.
**Heat Transfer in Fluids**

At this point the Heat Transfer interface is set up. Start by defining the conductive heat transfer in the supporting solid walls. Note that physical properties of the walls are taken from the material called Walls, associated with that domain.

**Heat Transfer in Solids**

2. In the Heat Transfer in Solids settings window under Domain Selection, select Supporting walls from the Selection list.

Next specify the Heat Transfer in Fluids feature, accounting for convective and conductive heat transfer in the channel blocks.

**Heat Transfer in Fluids**

1. Click the default Heat Transfer in Fluids node.
2. In the Heat Transfer in Fluids settings window under Model Inputs, from the Absolute pressure ($p$) list select Pressure ($dl/dlm1$).
3. From the Velocity field ($\mathbf{u}$) list select Darcy’s velocity field ($dl/dlm1$).
4. Under Heat Conduction, select User defined from the Thermal conductivity ($k$) list and select Diagonal from the list underneath.

Specifying the diagonal thermal conductivity elements allows you to represent anisotropic conductive heat transfer in the channel blocks.

5. In the $k$ table, enter these settings:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0.13</td>
<td>0.25</td>
</tr>
<tr>
<td></td>
<td>0.25</td>
</tr>
</tbody>
</table>
6 Under Thermodynamics, Fluid select
From material from each of these lists—
Density ($\rho$), Heat capacity at constant
pressure ($C_p$), and Ratio of specific heats
($\gamma$).

Heat Source 1
Associate the heat source due to the
exothermic chemistry with the channel
blocks. Note that the feature and the
expressions describing the heat source are
generated by the Generate-Space Dependent Model feature, linking the 3D
monolith model to the plug flow channel model.

1 In the Model Builder, click the Heat Source 1 node .
2 In the Heat Source settings window under Domain Selection, select Channel
blocks from the Selection list.

Setting the Boundary Conditions
Complete the set up of the Heat Transfer interface by assigning the temperature,
outflow, heat flux, and symmetry boundary conditions.

1 In the Model Builder click the Temperature 1 node . In the Temperature
settings window under Boundary Selection, select Inlet from the Selection list.
2 Click the Outflow 1 node . In the Outflow settings window under Boundary
Selection, select Outlet from the Selection list.
3 On the Physics toolbar, click Boundaries and
choose Temperature .
4 In the Temperature settings window under
Boundary Selection, select Inlet walls from the
Selection list. Under Temperature enter $T_{in}$ in
the Temperature ($T_0$) field.
The nodes in the Model Builder should match the
figure to the right so far.
5 On the Physics toolbar, click Boundaries and
choose Heat Flux .
6 In the Heat Flux settings window under
Boundary Selection, select Reactor surface
from the Selection list.
7 Under Heat Flux click the Inward heat flux button. In the Heat transfer coefficient \( (h) \) field enter 10. In the External temperature \( (T_{\text{ext}}) \) field enter \( T_{\text{amb}} \).

8 On the Physics toolbar, click Boundaries and click to add a second Heat Flux node.

9 In the Heat Flux settings window under Boundary Selection, select Outlet walls from the Selection list.

10 Under Heat Flux click the Inward heat flux button. In the Heat transfer coefficient \( (h) \) field enter 1.

11 On the Physics toolbar, click Boundaries and choose Symmetry.

12 In the Symmetry settings window under Boundary Selection select Symmetry from the Selection list.

The node sequence in the Model Builder under the Heat Transfer in Fluids interface should match this figure.

---

**Darcy’s Law Interface**

Follow these steps to set up the Darcy’s Law interface and describe the fluid flow.

1 In the Model Builder under 3D Model, click the Darcy’s Law (dl) node.

2 In the Darcy’s Law settings window under Domain Selection, select Channel blocks from the Selection list.
**Fluid and Matrix Properties 1**

1. In the Model Builder expand the Darcy's Law (dl) node and click Fluid and Matrix Properties 1.

2. In the Fluid and Matrix Properties settings window under Model Inputs, select Temperature (ht1/ht1) from the list.

3. Under Matrix Properties:
   - From the Porosity $\varepsilon_p$ list, select User defined. In the associated field, enter 0.75.
   - From the $\kappa$ list, select User defined. In the associated field, enter $4.27 \times 10^{-8}$.

**Pressure 1 and 2**

1. On the Physics toolbar, click Boundaries and choose Pressure.

2. In the Pressure settings window under Boundary Selection, select Inlet from the Selection list.

3. Under Pressure enter 70 in the $p$ field.

4. On the Physics toolbar, click Boundaries and click to add a second Pressure node.

5. In the Pressure settings window under Boundary Selection, select Outlet from the Selection list.
This completes the set up of the model equations describing the reacting flow and heat transfer in the monolith. The sequence of nodes for the 3D Model in the Model Builder should match the figure.

Before solving the problem numerically, the geometry needs to be discretized with a mesh.

**Mesh**

First create an unstructured mesh at the reactor inlet face and then complete the mesh by sweeping in the axial direction of the reactor.

1. In the Model Builder under 3D Model, right-click Mesh 1 and select More Operations→Free Triangular.
2. In the Free Triangular settings window under Boundary Selection, select Inlet end from the Selection list.
3. Right-click Free Triangular 1 and select Size.
4. In the Size settings window choose Inlet walls from the Selection list.
5 Click the Custom button in the Element Size section.

6 Under Element size Parameters select the Maximum element size check box, then enter 0.0022 in the associated field.

7 In the same manner, set the Resolution of narrow regions to 0.85.

8 On the Mesh toolbar, click Swept .

9 Right-click Swept 1 and select Distribution .

10 In the Distribution settings window under Distribution, enter 20 in the Number of elements field.

11 Click the Build All button then click the Zoom Extents button on the Graphics toolbar to view the entire geometry.
**Study 2**

It is time to solve the monolith model.

1. In the Model Builder expand the Study 2 node, then click Step 1: Stationary.
2. In the Stationary settings window, under Physics and Variables Selection, click the Reaction Engineering (re) row in the Physics column. In the table, click the Solve for column and click to change the check mark (✓) to an (✗) to remove Reaction Engineering from Study 2.

3. On the Study toolbar click Show Default Solver.
4. Expand the Study 2>Solver Configurations>Solver 2>Stationary Solver 1 node.

5. Under Stationary Solver 1, right-click the Direct node (✗). Select Enable. Changing from an iterative to a direct solver leads to shorter solution times at the expense of increased memory requirements. Changing the default solver settings in this way makes sense for the medium sized 3D model that is presented in this example.
Follow these steps to create the result plots for the 3D monolith model.

### 3D Plot Group 10
1. On the Home toolbar, click Add Plot Group and choose 3D Plot Group.
2. On the 3D Plot Group toolbar, click Isosurface.
3. In the Isosurface settings window under Expression, enter \((c_{\text{NO}} - c_{\text{NO}})/c_{\text{NO}}\_0\) in the Expression field.
4. Under Levels enter 20 in the Total levels field.
5. On the 3D Plot Group toolbar, click the Plot button.

The plot in Figure 25 on page 26 is displayed in the Graphics window.

### 3D Plot Group 11
1. On the Home toolbar, click Add Plot Group and choose 3D Plot Group.
2. On the 3D Plot Group toolbar, click Slice.
3. In the Slice settings window under Expression, click Replace Expression. Select Heat Transfer in Fluids 1>Temperature (T) from the list (or enter \(T\) in the Expression field).
4. Under Plane Data section enter 10 in the Planes field.
5. On the 3D Plot Group toolbar, click the Plot button.

The plot in Figure 26 on page 27 is displayed in the Graphics window.

### Data Sets
To generate a plot of the selectivity parameter S, first define a data set on the mirror plane cutting the channel blocks in half.

1. On the Results toolbar, click More Data Sets and choose Surface.
2 Select boundaries 6 and 15 only.

2D Plot Group 12
1 On the Home toolbar, click Add Plot Group and choose 2D Plot Group.
2 On the 3D Plot Group toolbar, click Surface.
3 In the Surface settings window under Expression, click the Replace Expression button. Select Definitions>Selectivity parameter (comp1.S) (or enter comp.S in the Expression field).
4 Right-click Surface 1 and select Height Expression.

5 On the 2D plot group toolbar, click Plot then click the Zoom Extents button on the Graphics toolbar to view the entire geometry.

The plot in Figure 27 on page 28 is displayed in the Graphics window.

As a final step, pick one of the plots to use as a model thumbnail.
1 In the Model Builder under Results click 2D Plot Group 12.
2 Click the Root node (the first node in the model tree). On the Root settings window under Model Thumbnail, click Set Model Thumbnail.

Make adjustments to the image in the Graphics window using the toolbar buttons until the image is one that is suitable to your purposes.